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A little bit of history

= Development for Neptus started in 2005

« Common software for ROV and AUV vehicles

 Mission files stored as XML and converted to specific formats using
XSLT

= LSTS acquired and / or developed several new vehicles

e Neptus evolved for supporting UAVs, ASVs and WSNs
» Added support for STANAG4586 protocol (for UAVs)

= LSTS created its own robotics software framework

 Extensive support for DUNE and IMC
e Open source as of 2012 (currently with 5 active developers)
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What’s Neptus?

= Neptus allows planning, control and revision of missions
performed by unmanned vehicles

Neptus supports multiple heterogeneous vehicles
e AUVs, UAVs, ROVs, ASVs, ...
« Controlled individually or as a team

= Neptus supports multiple operators
e Operators join in and access / control the network of vehicles

= Neptus can be extended through plug-ins

e Map layers, Data visualizations, Console widgets, Maneuvers,
Communication protocols, ...
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Neptus mission concept

= In Neptus, a mission is specified as
e A set of map features
e A set of programmed plans
e A set of vehicle configurations
A set of checklists

= The mission is usually...

» Created prior to execution (planning)
e Changed during execution (monitoring / revision / re-planning)
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Part 1: Using Neptus
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Neptus Requirements

= Neptus requires prior installation of Oracle’s Java Runtime
Environment version 7 or newer

= For 3D widgets an OpenGL-compatible graphics adapter is
recommended

= At least 1 GB of RAM (4 GB recommended)

= Compatible with Windows and Linux (known to work under
OSX but rarely tested)
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Installing and Running Neptus

= To install Neptus, just download the latest version to a
directory of choice

 Logs will be put under this directory so make sure you leave extra
room for them
= Downloading Neptus
 Use your favorite SVN client to checkout Neptus from
https://whale.fe.up.pt/svn/neptus/public/*/exec
= Running Neptus

e In Windows: run neptus.exe
e In Linux: execute ./neptus.sh
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The Neptus Workspace

i

ﬂ\ Neptus Workspace

File Systems Conscles Missions Maps Checklists  Mission Review  Communications Tools  Help

w Planner

~

@ Review & Analysis
a Console Open/Builder
' Checklist

h5 4

. IMC Menitor
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The Neptus Workspace

EI‘ Meptus Werkspace

File Systems Conscles Missions Maps Checklists  Mission Review  Communications  Tools  Help

/
Planner
-

@ Review 8 Analysis
a Console Open/Builder ——
Checklist
:u ecklist — >

‘ IMC Monitor
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The Neptus Workspace

ﬁ‘ Neptus Workspace

| R LauvAPDL - Checklist

File Systems Conscles Missions Maps Checklists  Mission Review  Communications  Tools

Help

.P Save as | | To PDF | | Run

| | Cancel |

j Name: LauvAPDL
Version:
Description:

PT - Lista material necessario para ura missdo com o Lauv na APDL
EN - Checklist to run APDL missions with the LAUV vehicle,

D Material Separado  (0/20)
] Mala PC Portatil (cinza) (0/4)

] Mala PELI PC Portatil (preta) (0/3)

*e_ lauy-seacon-1 - Yehicle Info :

=N =R ==

Info
Id: lauv-seacon-1

Name: LAUV-SeaCen-1
Model: LAUY
Type: AUV I

(3D model ][ Froperies ] L/W/H(m): [14x03x0.54

Files

File info

Type:

Href:

Description:

Inertial Coordinate System
Offset Angle North

Rotation over the vertical axis: (degrees)
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Neptus - Hands-on exercise

= Download and install Java 7
= Download and install Neptus

= Start Neptus and...
e Check the default IP for lauv-seacon-2

e Load the default lauv-seacon-1 console
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Neptus Consoles

= Neptus allow end-users to create Operational Consoles
» Based on existing widgets
« Adapted to specific missions/vehicles

= Mission console definitions are stored as XML

 .ncon file extension
e A sort of consoles are already bundled
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Neptus Consoles

Lat: 43N49.395 Lon: 15E34.290
Course: 000° | Heading: 006

Ground Speed: 0.0 m
Vertical Speed: 0.0 m/s

1P: 127.0.01 @udp:6002

WN\Opaaﬁnn\Imb\Sm\Td&Op\
s R0V A

lauv-seacon-1

uuy

uuv

ey

Service Mode
Alams,  Messages,

[i} 2 Synclogs Y'

lmmm—mrrrrrr
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Neptus Consoles

i o 3 i bl
Systems |I Operation | Info | Swte | Tele-Op |
\ | |

AL I TN v PN

v @&MP
SIMULATION

Lat: 43N49.395 Lon: 15E34.290
Height: -01 m

Course: 000° | Heading: 006
Ground Speed: 0.0 m/s
Vertical Speed: 0.0 m/s

RPM: O

IMCID: 00:15

1P:127.0.01 @udp:6002

lauv-seacon-2

[T = uuv

7 Synclogs %'

7 [T [0 [& 5
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Neptus Consoles

A" Neptus Console - lauv-seacon-1 - id_82801195 [murter.nmisz]

File Missicn Settings View Tools Planning Profiles  Help

L 4 Sysbems\()paaﬁnn\lnfo\ Stahe\Td&Op\
h | o=
&5 || Max Depth: 50.0 m
o | Min Altitude: 1.0 m Entity State | x | Description | At |
e [ dtove guUs =
Plan Generator |} [ active 00s
LBL [] expecting beac... 0.0 s
Leak Sensor - M... JELIM [ active 00s
Leak Sensor - Tail L0 [ | active 00s
Depth Sensor [ active 00s
IAHRS [] active 00s
Motor [ active 00s=
Mavigation [] maximum hori... 0.0 s
Echo Sounder [ active 00s
b [ active 00s

Error State
Error entities:

(8h33m55s - Mavigation: waiting for the solution to
converge

Main Vehicle: lauv-seacon-1
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Neptus Consoles

ﬁ\ MNeptus Conscle - lauv-seacon-1 - id_82801195 [murter.nmisz]

File Missicn Settings View Tools Planning Profiles  Help

%

Gotol

- ID. . . Gotol Plan Control
B Minimum time 0 ; .
b Mazximum time 10.000 m {"_} ('l’) ? @ 0 h
Initial Maneuver —
4 Speed 900 plan control state
' Speed units RPM State: BLOCKED
Location M43.823819°, E15.5... Plan:
¥ start-actions Plan Actions: Node:
3 end-actions Plan Actions: Last
event:
08h17m57s - booting

E=3 EcH

]
‘Operation \ Info \ State \ Tele-Op \

f N43.823006%, E15.571095°, alt:0.00 m
823243° E15.5714977, alt:0.00 m

-+ regression_test [lauv-xtreme-2]

. rows [lauv-xtreme-2]

== line [lauv-seacon-1]

ength: 119.82m
. Time: 2m 125

= Maneuvers: 2

A

Using Speed/RPM ratio: 1.3m/s (1000.0RPM)

43M49.449 / 15E34.2°

Main Vehicle: lauv-seacon-1 Active plan: regression_test

Vehicle: lauv-seacon-1

Q 0% 0%

0.ov

3 47% ®1I:II:I%

Editing line

Aams,  Mesages,

|

[ BNew |

Py

+

I save I * Close

[

? Synclogs W
L L

|07ha7m UTC

[ [EO/mJs [o
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Neptus Consoles - hands-on exercise

1. Make sure you have Neptus correctly installed in your
system

2. Open the seacon-light.ncon Neptus console

;. Set lauv-seacon-3 as the main vehicle in the console

+. Create a new plan for lauv-seacon-3

Sequence of 4 Goto maneuvers, forming a square of 60x60 meters
Set the plan depth to 5 meters and speed to 1200 RPM
Save the plan as plan_<yourname>

A LW N -

Send it to the the simulated vehicle
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Neptus Consoles - log download dialog

2501 _idle | 20120926/002501 _idle/Data.lsf (G.7MIB)
& 20120926,/002501 _idle/Config.ini (31.6KiE)

4

5 446 W2 ) L4 P

l_ 61.84GiB _J

k]

1A' Download Log Files =2 ESR
lauv-seacon-1 \l\
Log Folders Log Files
£ 200120926/003257_idle E o 20120926/002501 _idle/Output.bed (4.1KIE)
g 20120926/003013_idle | 20120926,/002501 _idle/IMC.xml (203.1KIE)

4]

20120926,/002501 _idle/Config.ini (http://127.0,0.1:8080/ dune/logs/download/20120926,/002501 _idle/Config.ini)

| 31.6KiB done (in 0.085 s) @371 3KiB/s

Saved in 'C:Userslosé PintowerkspaceMeptuslogdownloadedlauv-seacon-120120926002501 _idleCenfig.ini'

20120926,/002501 _idle/Data.lsf (http://127.0.0 1:8080/dune/logs/download/20120926/002501 _idle/Data.|sf)

| 11MIE of 6. 7MIE @3.3MIB/s - 1.7 s remaining

20120926,002501_idle/ IMCxrml (http://127.0.0 1:8080/ dune/logs/download/20120926,/002501 _idle/ IMC.xml)

| Starting...

1
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Neptus Consoles - log download dialog

ﬁ\ Download Log Files EI@

lauw-seacon-1 \\

Log Files

- J 20120926/002501 _idle/Output.tet (4.1KiB)
a0 20120926/003013_idle ) 20120926/002501 _idle/IMC.xml (203.1KiE)
i ) 20120326/002501_idle/Data.lsf (6.7MIB)
& 20120926,/002501 _idle/Config.ini (31.6KIE)

k]

] ef]le] Q) X] HIE2

20120926,/002501 _idle/Config.ini (http://127.0,0.1:8080/ dune/logs/download/20120926,/002501 _idle/Config.ini)
1.6KiB done (in 0.085 5) @371.3KiB/s
orkspaceMeptuslogdownloadedlauv-seacon-120120926002501 _idleConfig.ini'

-
|

l_ 61.84GiB _J

4]

L

ata.lsf (http://127.0,0.1:8080/dune/logs/download/20120926/002501 _idle/Data.lsf)
11MIE of 6. 7MIE @3.3MIB/s - 1.7 s remaining

[ 20120926,002501_idle/ IMCxrml (http://127.0.0 1:8080/ dune/logs/download/20120926,/002501 _idle/ IMC.xml)

Starting... | b @]]

1
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Neptus Mission Review and Analysis

= Can be acessed
e Directly by right-clicking a downloaded log
e From the Neptus workspace

= Compatible with LSF log folders
 Data.lsf (binary concatenation of IMC data)
e IMC.xml (definition of the protocol used in the LSF)
 config.ini (used vehicle configuration)
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Neptus Mission Review and Analysis

= Can be acessed
e Directly by right-clicking a downloaded log
e From the Neptus workspace

= Compatible with LSF log folders
 Data.lsf (binary concatenation of IMC data)
e IMC.xml (definition of the protocol used in the LSF)
 config.ini (used vehicle configuration)
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Neptus Mission Review and Analysis

File Report Settings Tools

Neptus Mission Re

[ LLF Listing

b T e b AT e S b e S B e b T b S e S i -

i-[wf acceleration

[+f angularvelocity

W Annource

“f BottomDistance

[+f conductivity

[+ controlLoops

@ Cpullsage

@ Current

[+ Dapth

[+f Desiredaltitude

[+ DesiredControlTorque
[+ DesiredDepth

[+ DesiredHeading

[+f DesiredHeadingRate
[+ DesiredPath

[+ Desiredpitch

[+ Desiredspeed

@ DevDataText

[+4 Entityinfo

[«d EntityList

[«f EntityState

[+f Estimatedstate

[+f EstimatedStreamivelac
[+f Eulerangles

[+f FuelLevel

@ GpsFix

[+4 GpsFixRejaction
[+ Groundvelocity
| Heartbeat
i-[wf HomeRef

& [uf LblConfig

Latitude

41
41
41
41
41
41
41
41
41
41
41
41
41

.18500 4
.184395 4
.18430 4
.18485 4
.18480 4
.1B475 A
.18470 4
18485 4

B Network &, CSVData ' ©) SidescanPlot ' [1}Log Book
[ Estimated State

18565
18380 -
18555
18550 -
18345 -
18540 -
18535
18330 -
18525
18520 -
128515
18510 -
18505 -

' [ LBL Ranges % [ Euler Angles

5[4 LbiDetection

] |

Estimated State

ymetry3d ', % Replay ' # Statistics/Replay Msg |

% [ Path control errors ', & Bathymetry Plot ', M Raw Messages

-B. 70625
Longitude

-B. 706800

lauv-xtreme-2 . Estimated State

-8. 70550

Time Step: Redraw

Log: 091706 demo_ss 1m | Date: 11/May/2012 | System: LAUV-Xtreme-2
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Neptus Mission Review and Analysis

T\ Neptus Mission Review And Analysis - 4+ X

File Report Settings Tools

[ LLF Listing |~ B Network &, CSVData ' @ SidescanPlot '(1iLogBook ' @ Bathymetry3d ' #;Replay ' % Statistics/Replay Msg
@[ Acceleration 7 []Estimated State | [1LBLRanges ' [1CTD Data ' []Euler Angles ' []Path control errors ' @ BathymetryPlot ' M Raw Messages
@[ Angularvelocity X <

@48 Announce

&[4 BottomDistance
&[4 Conductivity

|*f ControlLoops

e CpuUsage

[wd current

|48 Depth

[48 DesiredAltitude

[+f DesiredControlTorque
[+f DesiredDepth

[+ DesiredHeading

['4f DesiredHeadingRate
[+f DesiredPath

[+f DesiredPitch

|uf DesiredSpeed

}':‘7'3 DevDataText

[wd Entityinfo

[wf EntityList

[ EntityState

[+ EstimatedState

[wf EstimatedStreamveloc
[+d Eulerangles

[uf FuelLevel

i 'iGpsFix

[ GpsFixRejection

[ef Groundvelocity

i Heartbeat

& HomeRef

[+d LblConfig

[+d LblDetection =

41N11.107 8W42.381
altitude: 1.0m speed: 2.64m/s
angle: -16.34°

&

)

L

-

&8

&

+}

}

) -

&

&

&

-

&

NOTE: According to available

-

data, a different set of automatic

Log: 091706_demo_ss_1m | Date: 11/May/2012 | System: |

visualizations is loaded
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Neptus Mission Review and Analysis

2

File Report

Settings Tools

Neptus Mission Review And Analysis

L= LLF Listing

5 [wd Acceleration

-

Frm O O OO OO0 v OO BN = OO o OO e = WO s OO r OO SO e OO e OO TN = OO OO v WO = OO OO0 v WO = OO v OO = N == DO =

7w Angularvelocity
}@ Announce
[ BottomDistance
7w Conductivity
& Controlloops
}@ Cpullsage
o[ Current
&[4 Depth

718 DesiredAltitude

7 DesiredControlTorques
& DesiredDepth

&[4 DesiredHeading

7 DesiredHeadingRate
& DesiredPath

o[ Desiredritch

7 DesiredSpeed

& DevDataText

& Entitylnfo

o[ EntityList

& [wf EntityState

& EstimatedState

7 [ EstimatedStreamveloc
7w Eulerangles

&8 FuelLevel

& GpsFix

7 GpsFixRejection

748 Groundvelocity

uf Heartbeat

- [wf HomeRef

&8 LbiConfig

- [F LbiDetection

2D

[4]

| network &, CSVData ', ©) Sidescan Plot ([} Log Book ', &) Bathymetry3d | % Replay | # Statistics/Replay Msg

[]Estimated State ' []LBLRanges ' [1CTD Data ' [1Euler Angles ' []Path control errors ' & Bathymetry Plot ' | Raw Messages

B -t '] Entity: lDepth & Heading Control ']Time step (s): (0.1 Image width: 800 | height: |800 ‘ | Recreate || Save|

Bathymetry =
2.20m
5.92m

. G5.85m

13.39m

NOTE: According to available

{4

Log: 091706 demo_ss_1m | Date: 11/May/2012 | System:

data, a different set of automatic

'FEU

visualizations is loaded
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Neptus Mission Review and Analysis

') Meptus Mission Review And Analysi

LLF Listing & Bathymetry Plot -"'.I B Raw Messages | [ Network SV Data 1"., i Replay .I"u, K Statistics/Replay Msg "'I,l
Acceleration [] Estirnated State "I,I [] LBL Ranges "I,I [JCTDData | []Euler Angles "I,I [[] Path control erra ' &) Bathymetry3d | j Sidescan Plot |

Forwad
Cpulsage Right Camera direction
Current Back
Depth
iredAltitude
ControlTorques 1 Toggle water disigiay
Depth
Heading
edHeadingRate 3 Toggle onjoff the sky
edPath
Pitch

2 Toggle terrain color

Water level 54.09m
Geoid level 55,49 m

EstimatedState Maximum terrain height 6,69 m
EstimatedStreamVelocity

EulerAngles

Ground
Heartbeat

Minimum terrain height
LblDetection TIP: You may need an accelerated
Log: 091706_demo_ss_1m | Date: 11/ 2 3 ,'*Itrer'r‘lr; graphics adapter in Order fOl' thiS tO
) work
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Neptus Mission Review and Analysis

T\ Neptus Mission Review And Analysis g e

File Report Settings Tools

(= LLF Listing = | Network &, CSVData ' @) SidescanPlot ' [(}LogBook ' & Bathymetry3d ' #iReplay ' & Statistics/Replay Msg
-8 Acceleration []Estimated State | [1LBLRanges ' [1CTD Data ' [JJEulerAngles ' []Path controlerrors ' @ BathymetryPlot ' M Raw Messages

[+d Angularvelocity =
{lTrﬂAnnounce gg gq « » I 1 09:18:38.423 (4.0%)|

Iﬁﬂ BottomDistance
[wf Conductivity

[+d controlLoops
[+ cpuUsage

[wf current

[+f Depth

[+d Desiredaltitude

Jug DesiredControlTorques%
[+f DesiredDepth '

[+f DesiredHeading
[+7 DesiredHeadingRate

|*f DesiredPath
[+ DesiredPitch
¥ DesiredSpeed

l‘ﬁ, DevDataText

[wd Entityinfo
|4 EntityList
[ed EntityState

[+d EstimatedState

[ EstimatedStreamVeloc
[+d Eulerangles

[+8 FuelLevel

[+d GpsFix

[wf GpsFixRejection
[wf Groundvelocity
' Heartbeat

i -[48 HomeRef

& [ LblConfig
{4 LbIDetection

| ARG P N

Log: 091706_demo_ss_1m | Date: 11/May/2012 | System: LAUV-Xtreme-2
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Neptus Mission Review and Analysis

[»]

4]

auntreme: T|P: You can more thouroughly

Log: 091706 dema_ss 1m | Date: 11/May/2012 | System:

Universidade do Porto

inspect a specific message by
“double clicking it in this mode

T\ Neptus Mission Review And Analysis - + ®
File Report Settings Tools
= LLF Listing Q\Announce[m 27:10.555] '\ [E EstimatedState @\ EstimatedState[10:17:06.773] ° [EAcceleration |
=-[ Acceleratias ' ,CSWData ' ©) SidescanPlot ' [[}logBook ' § Bathymetry3d ' %iReplay ', # Statistics/ReplayMsg ' [E Announce
- X time ow Acceleration d > '\ [1LBLRanges ' [1CTDData ' [1EulerAngles ' []Pathcontrol errors ' @ BathymetryPlot ' B Raw Messages |,

Xox View communication src | src_ent| dst| dst_ent| time | X | y | z

Xy 10:17:06,46 MU ko 2282622 0,1350282645783387 m/s/s -0,168727924280148 m/s/s 9.614769583794475(~

~Xz 10:17 10805283509762957 m/s/s 0.17680101182693614 m/s/s  -0.654138886530534/:
G- W angularvelocity 10:17 10209555239472537 m/s/s -0.17084599414535449 m/sfs  -9.654141224718094
®-[4 Announce 10:17 09153246552995406 m/s/s -0.1743163554043509 m/s/s -0,668462011015414
@-[% BottomDistance 10:17: - 10988733115457464 mis/s 0.17192451009806245 m/s/s  -9.605995031532355
B[ Conductivity 10:17:06.524 lauv-streme-2 MU EI 2282.722 0.07770461384872905 m/s/s -0.13855426547840944 m/s/s  -9.737433255010872
®-[4 Controlloops 10:17:06,545 lauv-streme-2 MU ko 2282,742 0.08033037750874648 misis 0.12426957204207649 mfs/s  -9.775472126026008
-4 Cpuusage 10:17:06.564 lauvstreme-2 MU EI 2282.762 0.06870661174305714 mis/s -0.1099115051089786 m/s/s -9.81354959638586 1
@[ Current 10:17:06,584 lauv-xtreme-2 MU LI 2282,782 0.057100148738619 m/s/s -0.10622236826745793 m/s/s  -9.849274505239725
@-[4f Depth 10:17:06.606 lauvstreme-2 MU LI 2282802 0.06438640132322906 mis/s 0.08486975623774341 m/sfs  -8.878953019666571
&[4 DesiredAltitude 10:17:06.624 lauvstreme-2 MU koK 2782.822 0.05641037180959247 m/s/s 0.07643735212557949 m/sfs  -9.925366395795345
®-[4f DesiredControlTorques | |10:17:06.645 lauvstreme2 MU k% 2282842 0.06140167272428516 misis -0.07046882650945335 m/s/s  -9.9586584245443324
@-[4F DesiredDepth 10:17:06.664 lauvstreme-2 MU kK 2282,862 0.048665497950861226 mis/s  -0.05371284433788425 m/s/s  -10.00744495854513
B[ DesiredHeading 10:17:06.684 lauv-streme-2 MU EI 2282882 0.03388330003987066 mis/s -0.040528373210690916 mfs/s  -10.04315573937364
®-[4f DesiredHeadingRate 10:17:06,704 lauvstreme-2 MU ko 2282,902 0.04608737731100991 mis/s 0.027457771920843515 mfs/s  -10.09068905894295
[+ DesiredPath 10:17:06.724 lauvstreme-2 MU EI 2282.922 0.04140026930754919 m/fs/s 0.023859094408329107 mfs/s  -10.10021325861351
[ DesiredPitch 10:17:06,745 lauv-streme-2 MU LI 2282942 0,051053301755851134 mys/s  -0.0250537132036647 m/fs/s 10,11923126381635
@-[4f DesiredSpeed 10:17:06.764 lauvxtreme-2 MU LI 2282,962 0.04994726760955527 misis 0.013166864738555158 mis/s  -10.13467433214187
B[ DevDataText 10:17:06.784 lauvstreme-2 MU koK 2782.982 0.05113740897588431 m/s/s -0.008428501401070388 m/fs/s -10.13703930770754
-[4F Entityinfo 10:17:06.804 lauv-streme-2 MU k% 2283002 0.04644901369763538 misis 0.009401142400575917 m/s/s  -10.15247653081417
@-[48 EntityList 10:17:06.824 lauvstreme-2 MU kK 2283.022 0.0580875112415757 m/s/s 0.021137649538205003 m/sfs  -10.12742275357842
B[ Entitystate 10:17:06.845 lauv-streme-2 MU k¥ 2783.042 0.04723910462940111 m/s/s 0.041311367581389675 m/s/s  -10.11550201415015
& H EstimatedState 10:17:06,864 lauvstreme-2 MU ko 2283062 0.056630106374341994 m/s/s  0.07843370444141327 m/s/s -10.117513932850445

o X ref 10:17:06.884 lauvstreme-2 MU kK 2283.082 0.05146824379885966 mis/s 0.109185391 92455996 mys/s -10.07817795341610

Xox 10:17:06,904 lauv-streme-2 MU LI 2283,102 0.06054495543024968 mis/s 0,15409189802119508 m/s/s -10.04349359352588

Xy 10:17:06.924 lauvstreme-2 MU LI 2283122 0.05652658206778578 misis 0.19787096185721456 mis/s -10.00412136808037

Xz 10:17:06.945 lauvstreme-2 MU ko 2283142 0.061211566112819124 m/s/s  0.23800323015609753 mys/s 9.94212113124132 1

- X phi 10:17:06,964 lauv-streme-2 "™t o Q70T 1AT N NSTOTIANARAT TITON mjg)g 0.20545840793279927 mis/s -8,903864173561335| |

- X theta I~ [110:17:08.984 sis 0.36468032089862973 mis/s ©.865663329982757| 7

:I [+]
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Neptus Mission Review and Analysis

T\ Neptus Mission Review And Analysis - 4 ¥
File Report Settings Tools

(= LLF Listing
B m Acceleration

[ lauv+treme-2. Acceleration.z " [ lauvstreme-2.Acceleration.z, lauvtreme-2.Acceleration.x \

@\ Announce[10:27:10.555] ', [E EstimatedState ', @\ EstimatedState[10:17:06.773] ' [E Acceleration ', @ Acceleration[10:17:06.481]

W Wetwork | &, CSvData |, ©) SidescanPlot '\ [[}logBook ', § Bathymetry3d | % Replay ' # Statistics/ReplayMsg ' [E Announce
[]Estimated State ' [JLBLRanges ' [1CTD Data ' []Euler Angles ' []Path control errors ' & BathymetryPlot ' @ Raw Messages |

lauv-xtreme-2.Acceleration.z, lauv-xtreme-2.Acceleration.x

~[ud A Flot data on ne
@ EottomDistance
-8 Conductivity
-[ud contrelLoops
- Cpulsage

@ Current

-+ Depth

-[wd Desiredaltitude
-[&f DesiredControlTorques
-[+f DesiredDepth

-[wf DesiredHeading

-[&f DesiredHeadingRate -5
-[+f DesiredPath
-[wd DesiredPitch
-[uf DesiredSpeed =
@ DevDataText
- Entityinfo

~[wd EntityList 5
- EntityState A P - " PRI Y ¥ PO T P -
s Entity 10 W, o e " N # Pt SEE el b |

m EstimatedsState

-4

-&

I I I I I I I W e W s W
L S e ] S T

it

10:17 10:18 10:19 10:20 10:21 10:22 10:23 10:24 10:25 10:26 10:27 10:21
Tirne of day

|I lauw-xtreme-2 . Acceleration.z. MU M lauwv-xtreme-2 . Acceleration. .MU |

y EDB Time Step: Redraw

1

[4]

Log: 091706_demo_ss_1m | Date: 11/May/2012 | System: LAL TIP You can SeleCt mUItlple
fiels by holding the Ctrl key
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Neptus MRA - Hands-on exercise

= Download and unpack the log archive tutorial_log.zip
= Load the log into MRA
= Try to find:

« Maximum depth of the vehicle
e Maximum speed

e Distance between start and end locations

F E U P Universidade do Porto
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Part 2: Extending Neptus
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Requirements for extending Neptus

= For developing Neptus extensions you need Oracle’s Java 7
JDK

 This package includes the Java virtual machine and compiler

= Neptus should be developed under Eclipse
« Recommended version is Eclipse IDE for JEE developers

= To commit changed code you need a Subversion client
e Subclipse Eclipse plug-in is recommended

F E U P Universidade do Porto
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Configuring Eclipse - 1

= Install Subclipse plugin (optional) in Eclipse

e Help > Install new Software

« Use the update site http://subclipse.tigris.org/update_1.8.x

e Instal Subclipse

Available Software
Check the iterns that you wish to install.

Work with:  Subclipse 1.8.x Update Site - http://subclipsetigris.org/update_1.8.x

Find m

type filter text

MName

a [J] 000 Subclipse
“y CollabMet Merge Client
L Subclipse (Required)
L Subclipse Integration for Mylyn 3. (Optional)
Le Subversion Client Adapter (Required)
L+ Subversion JavaHL Native Library Adapter
L Subversion Revision Graph

4 00 SWNKit

| SelectAll || Deselect Al O items selected

3011
1516
300
183
176
111

Add...

Universidade do Porto
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http://subclipse.tigris.org/update_1.8.x
http://subclipse.tigris.org/update_1.8.x

Configuring Eclipse - 2

=« Add the Ant view to the
default nga
perspective + G A

& Ant
I = APITools

e« Window > Show View > L C/Cer

o CVS

Other > Ant [» [= Data Management

[» = Debug

F E U P Universidade do Porto
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Import or Checkout Neptus Project

oy A= leEwee— — w=era

Select Folder
Select the folder to be checked out from SV,

gg

Import Projects - .
/1y No projects are found to import

[ = SpotUpdater
[+ = artwork
[ = branches
[+ = docs-development
[+ [ plugins
[» [= public
[ [ releases
[» [= tags
a = trunk |
[» [= .settings
[ = MSIS releasze
[» = UML
i = bin
I = bin-bundles
[ = certs
I = checklists
I = conf

r 2 dev-serinte

m

(II

-
@ Select root directory: | C\Users\José Pinto\workspace\Meptus Browse...
() Select archive file: Browse...
Projects:

Select All

Deselect All

Refresh

[T Copy projects into workspace
Working sets
[T Add project to working sets

“Warking sets: Select...

|| Enish || Cancel

: FE U Universidade do Porto
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Testing Neptus

= Main class: pt.up.fe.dceg.neptus.loader.NeptusMain

= Right-click it and select Run As > Java Application

'FEU

_J Project explorer oo =) e
> 3 pt.up.fe.dceg.neptus.gui.tablelay
> 3 ptup.fe.dceg.neptus.guitree
» 3 ptup.fe.dceg.neptus.il8n
> 3 pt.up.fe.dceg.neptus.junit
> 3 pt.up.fe.dceg.neptus.junit.plugir
> 3 ptup.fe.dceg.neptus.junit.types.
> 3 ptup.fe.dceg.neptus.junit.util
> 3 ptup.fe.dceg.neptus.junit.util.ca
4 f} ptup.fe.dceg.neptus.loader
b [} FileHandlerjava 6498 02-01-
b [#} MissionConsoleLoader.java 4
b [J) MissionConsoleWebStart.jav
b [5} MissionPlannerLoader.java 4
b [J} MissionPlannerWebStart java
> |[J) NeptusMain.java 8457 25-09
b [J} Viewer3DLoader.java 6498 02
b [J} WorkspaceChecker.java 6498

> 3 pt.upfe.dceg.neptus.mc

> 3 ptup.fe.dceg.neptus.messages
3 pt.up.fe.dceg.neptus.messages.|
£ pt.up.fe.dceg.neptus.mge

> H# ptup.fe.dceg.neptus.mme

> 3 pt.up.fe.dceg.neptus.mme.wms

> 3 ptupfe.dceg.neptus.mp

> 3 pt.up.fe.dceg.neptus.mp.actions

> H#3 ptup.fe.dceg.neptus.mp.maneu

Universidade do Porto
Faculdade de Engenharia
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2T
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N
el

Show In
Open
Open With

Copy

Copy Qualified Name
Paste

Delete

Remove from Context
Build Path

Source

Refactor

Import...
Export...

Refresh

References

Declarations

Run As
Debug As
Profile As
Validate

Alt+Shift+W »
F3
»

Ctrl+C

Ctrl+V

Delete

Ctrl+Alt+Shift+ Down
»
Alt+Shift+S »
Alt+Shift+T »

F5

v

v

s 1Runon Server
(31 2Java Application

Run Configurations...

2

J1



Compiling Neptus

= Drag the file Neptus/build.xml into the Ant view

= This will list all the available Ant targets

= The default target compiles and packages Neptus core

= To run any target double click it

2t Markers [] Properties & Servers (4 Data Source Explorer |5 Snippets [Z) Console & Progress < Search [g) History & Ant 3
4 ;ﬂ—d Neptus
. @ clean
. @ compile
(@& create-sh-bat-filters
@ create-svn-props
(@ createworkspacejar
@ delete-jre-linux-dir
(@ delete-jre-linux-tgz
. (@ delete-jre-windows-dir
. (@ delete-jre-windows-tgz
. (@ dist le linux

F E U Universidade do Porto
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Creating a plug-in

= A Neptus plug-in is a set of Java classes that extend
Neptus, packaged into a .jar file

= Plug-ins can be
e MRA visualizations
e Console displays
e Map interactions / layers

= Extensions are idenfied by a special Java Annotation and a
an entry in the plugins.lst file...

e They are afterwards inspected for extension points

(A F E U P Universidade do Porto
Faculdade de Engenharia



Hello World Plug-in (Console display)

= Add a new source folder to Neptus (plugins-dev/tutorial)

= Add a new package in that source folder
(pt.up.fe.dceg.neptus.plugins.tutorial)

= Add a new class under this package (HelloWorld)

» Make it extend the class SimpleSubPanel
« Add the @PluginDescription annotation to this class

E U P Universidade do Porto
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Hello World plug-in

File Edit Mavigate Search Project Run  Window Help
R AFRNFERETRFRE A RPN - CER|Grer|®@e |9 2| E T

| ) w Sl et o v| - Quick Access ﬁl‘ﬁiﬁDebug

[7 Project Explorer 53 E|| @ T =0 plugins.st 2 | [J] HelleWorld.java = 0

b [ plugins-dev/trex - # DATE=@DATE@ -
& £ plugins-dev/3D

& 4 plugins-dev/mat

B plugins-dev/ais

b [ srcTests

a [ plugins-dev/tutdfia
4 {2 ptup.fedceg.neptus.plugins.tuterial Pt-“P-fe-dCEE-”EPtUS-P]-“ES-tUt‘:‘f‘iE]--HE]-]-OHOT‘]-d

b [# HelloWorld.java L
Z2 plugins.lst

@EI log4j-1.216.jar 7583 20-06-2012 14:59 mfaria

@, xml-apis.jar 2785 23-08-2008 20:12 pdias

@3 xerceslmpl.jar 716 14-10-200514:46 pdias

@3 domd4j-1,61.jar 651 25-08-200516:23 pdias

|&F|E\ jaxen-111.jar 7583 20-06-2012 14:59 mfaria

|1:|E, serializer,jar (from Class-Path of xalan.jar) 716 14-10-2005 1.
@E, xalan,jar 716 14-10-2005 14:46 pdias

|1F|E| StarfireBxt.jar 161 23-03-200512:32 rjpg

@EI activation.jar 304 28-04-200516:06 zepinto

@, mail.jar 304 28-04-200516:06 zepinto

@3 soap.jar 304 28-04-2005 16:06 zepinto

@3 comm.jar 319 10-05-200519:43 slfraga

|&F|E\ commons-net-1.4.0,jar 417 31-05-2005 15:10 pdias

|1:|E, wms,jar 471 17-06-2005 16:20 zepinto

@E, 12fprod-common-all.jar 2037 28-03-2007 20:29 zepinto

|1F|E| avalon-framework-4.2.0.jar 2785 23-08-2008 20012 pdias
@EI Jimi-1.0jar (from Class-Path of fopjar) 837 14-12-200519:1 M... P... L5 ¥ED. [Bs. BC. 32 =P g H B = g

= . - . o B A
fof fop.jar 2785 23-08-2008 20:12 pdias .
.ﬁ. e —atl. tee WTOLE VT A0 WONE WA T e e o x % | |——:-l“ &'—E EI @I | =|_|' E - rﬁ -

4 L1 <terminated> HelloWorld llava Apolication] CYProaram Files\Javatidkl.7.0 07\bin\iavaw.exe (26 de

Writable
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Hello World plug-in

File Edit Mavigate Search Project Run  Window Help
R AFRNFERETRFRE A RPN - CER|Grer|®@e |9 2| E T

| ) w Sl et o v| - Quick Access ﬁl‘ﬁiﬁDebug

[7 Project Explorer 53 E|| @ T =0 plugins.st 2 | [J] HelleWorld.java = 0

b [ plugins-dev/trex - # DATE=@DATE@ -
& £ plugins-dev/3D

& 4 plugins-dev/mat

B plugins-dev/ais

b [ srcTests

a [ plugins-dev/tutdfia
4 {2 ptup.fedceg.neptus.plugins.tuterial Pt-“P-fe-dCEE-”EPtUS-P]-“ES-tUt‘:‘f‘iE]--HE]-]-OHOT‘]-d

b [# HelloWorld.java L
Z2 plugins.lst

@EI log4j-1.216.jar 7583 20-06-2012 14:59 mfaria

@, xml-apis.jar 2785 23-08-2008 20:12 pdias

@3 xerceslmpl.jar 716 14-10-200514:46 pdias

@3 domd4j-1,61.jar 651 25-08-200516:23 pdias

|&F|E\ jaxen-111.jar 7583 20-06-2012 14:59 mfaria

|1:|E, serializer,jar (from Class-Path of xalan.jar) 716 14-10-2005 1.
@E, xalan,jar 716 14-10-2005 14:46 pdias

|1F|E| StarfireBxt.jar 161 23-03-200512:32 rjpg

@EI activation.jar 304 28-04-200516:06 zepinto

@, mail.jar 304 28-04-200516:06 zepinto

@3 soap.jar 304 28-04-2005 16:06 zepinto

@3 comm.jar 319 10-05-200519:43 slfraga

|&F|E\ commons-net-1.4.0,jar 417 31-05-2005 15:10 pdias

|1:|E, wms,jar 471 17-06-2005 16:20 zepinto

@E, 12fprod-common-all.jar 2037 28-03-2007 20:29 zepinto

|1F|E| avalon-framework-4.2.0.jar 2785 23-08-2008 20012 pdias
@EI Jimi-1.0jar (from Class-Path of fopjar) 837 14-12-200519:1 M... P... L5 ¥ED. [Bs. BC. 32 =P g H B = g

= . - . o B A
fof fop.jar 2785 23-08-2008 20:12 pdias .
.ﬁ. e —atl. tee WTOLE VT A0 WONE WA T e e o x % | |——:-l“ &'—E EI @I | =|_|' E - rﬁ -

4 L1 <terminated> HelloWorld llava Apolication] CYProaram Files\Javatidkl.7.0 07\bin\iavaw.exe (26 de

Writable

F E U Universidade do Porto
. Faculdade de Engenharia 40




Hello World plug-in

] plugins.lst [J] HelloWorldjava &2
package pt.up.fe.dceg.neptus.plugins.tutorial;

// Eclipse allows automatic import organization (CTRL+SHIFT+0)
@ import java.awt.BorderLayout;[]

// This annotation is essential for the plug-in to be discovered
@PluginDescription(name="Hello World Plugin”)
public class HelloWorld extends SimpleSubPanel {

private static final long serialVersionUID = 1L;

= public HelloWorld() {
// remove default UI
removeAll();
setLayout(new BorderLayout());

// add a simple label that displays some text
add(new JLabel("Hello World!"));

}

// Test the Console plug-in directly in an empty console
public static void main(String[] args) {
ConsoleParse. testSubPanel (HelloWorld.class);

FE U Universidade do Porto
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Plug-in properties

= Console edition mode can be entered also by pressing F12
e Right-click a panel and choose properties to change its parameters

package pt.up.fe.dceg.neptus.plugins.tutorial;

/{ Eclipse allows automatic import organization (CTRL+SHIFT+O)
import java.awt.BorderLayout;[]

// This annotation is essential for the plug-in to be discovered
@Pluginbescription{name="Hello World Plugin™)
public class HelloWorld extends SimpleSubPanel {

private static final long serialVersionUID = 1L;

@NeptusProperty(name="Text to display™)
public String text = "Hello World!™;

public HellokWorld() {
[/ remove default UI
removeAll();
setlayout({new BorderLayout());

// add a simple label that displays some text
add{new JlLabel(text));

i

/I Test the Conscle plug-in directly in an empty console
public static void main(5tring[] args) {
ConscleParse. testsubPaonel (Hellokorld.class);

. FE U Universidade do Porto
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Plug-in properties - detecting changes

// This annotation is essential for the plug-in to be discovered
iPluginDescription(name="Helloc World Plugin™)
public class HelloWorld extends SimpleSubPanel] implements ConfigurationListener |{

private static final long serialVersionUID = 1L;

NeptusProperty(name="Text to display")
public String text = "Helloc World!";
protected JLabel 1bl = new JLabel(text);

public HelloWorld() {
!/ remove default UI
removeAll();
setLayout(new BorderLayout());

// add a simple label that displays some text
add(1bl);

h

@override

public void propertiesChanged() {
1bl.setText(texk);

¥

{// Test the Console plug-in directly in an empty console
public static woid main(String[] args) {
ConsoleParse.testSubPanel (HelloWorld.class);

h

F E U Universidade do Porto
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Console Plug-ins: sending messages

[@Pluginbescription(name="Hello World Plugin:}
public class HellolWorld extends SimpleSubPanel {

private static final long serialVersionUID = 1L;

protected void doSomething() {
PlanContrel pc = new PlanControl();
pc.set type(PlanControl.TYPE.REQUEST);
pc.set_op(PlanControl.OP.5TART);
pc.set_plan_id{"my_plan™);

send(getConsole().getMainVehicle(), pc);

h

public HelloWorld() {
// remove default UI
removeAll();
setlayout(new BorderLayout());
JButton btn = new JButton("Do something™);
btn.addActionListener({new ActicnlListener() {

@override
public woid actionPerformed{ActionEvent e) {
doSomething();
¥
1)s
add(btn);

F E U Universidade do Porto
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Console Plug-ins: receiving messages

@Pluginﬂescriptinn[name="HE110 World Plugin®™)
public class HelloWorld extends SimpleSubPanel implements|Messagelistener<MessageInfo, IMCMessage> |{

private static final long seriglVersionUID = 1L;

public HelloWorld() {

Imc3MsgManager.getManager().addListener(this);
¥

yercide
public void onMessage(MessageInfo argl, IMCMessage argl) 1
it (argl.getId() == Announce.ID STATIC) 1|
info("Received anncunce from "+argl.getString("sys _name"));
¥

¥

// Test the Conscle plug-in directly in an empty console
public static woid main(String[] args) {
ConsoleParse. testSubPanel (HelloWorld. class);

¥
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Plugin example - Map interaction

@PluginDescription(name="5%ample Map Intecaction”)
public class SampleInteraction extends|SimpleRendererInteraction|q

private static final long serialVersionUID = 1L;
protected String text = "inactive";

[@override

public bﬂﬂlead isExclusive() |1
return true;

1

[@override
public void|paint({Graphics2D g, StateRenderer2D renderer)){
g.drawString(text, 18, 18);

¥
[@override
public void|setActive(boolean mode, StateRenderer2D source) {
if (mode)
text = "active”;
else
text = "inactive";
¥
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Plugin example - Map interaction

@Pluginbescription(name="5ample Map Interaction”)
public class SampleInteraction extends SimpleRendererInteraction {

private static final long serialVersionUID = 1L;

[@verride
public boolean isExclusive() {
return true;

¥

@override
public woid mGUSECIickEd[HGUEEEVEHt event, StateRenderer2D source) {
info("mouse clicked at "+source.getRealWorldLocation(event.getPoint()));

¥

[@override
public woid mﬂuseﬂﬂvedlﬂﬂuseEvent event, StateRenderer2D source) {

Hfe..

¥
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Plug-in example MRA Visualization

@PluginDescription({name="Sample MRA Visualization™)
public class SampleMraVis extends SimpleMRAVisualization {

private static fimal long serialVersionUID = 1L;

public boolean canBeApplied(IMralogGroup source) {

|5

return source.getlog("EstimatedState”) != null;

@override
public JComponent getComponent(IMralogGroup scurce, double timestep) {

IMralog log = source.getlog("EstimatedState™);
double maxDepth = -Double.MAX VALUE;

for (IMCMessage m = log.firstLogEntry(); m != null; m = log.nextLogEntry()) {
double depth = m.getDouble("z"};
if (depth > maxDepth)
maxDepth = depth;
¥

return new JlLabel{"Max depth is "+maxDepth);
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Packaging the plug-in

= Run the Ant target named “plugin-create-jar”
= Input the name of the folder under plugins-dev/

= The jar is created under the plugins/ folder

o F E U P Universidade do Porto
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Become a commiter

= Neptus is currently under active development and your
help is most welcome

= To become a committer:

e Send a mail to the mailing list stating why you should become a
committer
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If you reached here you are
already a Neptus developer.

Welcome to the team!
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